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What's new in    ?Samplitude ProX 8

The most important innovations in     at a glance:Samplitude ProX 8

Take Lanes: Comping, i.e. combining sections from different audio and MIDI recording takes, no longer takes place in a separate
Take Composer window, but directly in the project below the track in the new Take Lanes.
Marker tracks: Markers are displayed in their own tracks. The height of the tracks can be freely adjusted so that long marker names
are no longer cut off by following markers. The markers can now also be colored, the Marker track head contains buttons for
creating, coloring and locking markers.
Simultaneous export to multiple formats: In the Export dialog, at  , you can now select multiple formats for simultaneousGenerate
export. When creating file names from templates, CD track metadata (author, title, album, etc.) can now also be used.
AudioWarp: Warp markers can now be set in audio objects to touch and move the audio, to correct irregularities in a recording, or to
change the audio rhythmically.
Many improvements for working in the project window:

New, meaningful mouse pointers for the editing areas in the track
Numerically adjustable volume directly at the object
optimized display of notes in a MIDI object
improved default settings for many display options
Color button in the object editor sets the object background color.

Help and  have been completely revised and updated. manual
VST3 plug-in compatibility and performance improvements.

New in 19.1

Overload-proof float recording: If your recording device supports true 32bit float recording, clipping can no longer occur in 32bit
 recordings, as levels above 0dB are also saved correctly in float format.(float)

Take lanes for MIDI recordings: Comping, i.e. combining sections from different recording takes, now also works for MIDI
recordings.
Scalable mixer faders: It is now possible to increase the height of the mixer window beyond the respective space requirements of
the individual sections in the mixer channels, allowing the mixer channel faders to be extended.
ARA2 plug-ins on the track: When loading ARA plug-ins into a track, the plug-in is automatically inserted into every object on the
track. This also works with objects added to the track later, for example if an object from another track is moved to the track.

New in 19.2

Simultaneous comping of MIDI and audio tracks: Audio and MIDI takes can now be switched together in the take lanes.
Optimized mixer handling: The size of the mixer window is now saved globally, i.e. it is now retained if the project is changed when
several projects are open. Docking of the mixer window (and other windows) when dragging can now be prevented if the  key isCtrl
also pressed.
More flexibility in waveform scaling: The scaling of the waveform display with fades/curves now has an additional scaling option
that only takes into account the object fades and volume curves without including the track volume/curves. The track volume is
therefore no longer included in the waveform display in the .standard setting
Many detail improvements:

More efficient creation of submix folder tracks, also possible via shortcut
Quick filtering of the displayed automation lanes by type (Vol, Pan, EQ...)
Menu command for selecting only the active track (keyboard shortcut Alt+Shift+Enter)
Improved compatibility with some ARA2 plug-ins

Over 100 bug fixes
EXCLUSIVE in Samplitude Pro X8 Suite: Steinberg SpectraLayers Pro 11



New functions and changes in detail

12/17/2024 Samplitude Pro X8 Version 19.2.2 Build 24222

for VST3 folders (bundles)[SEQ-8870] Improved handling 
Bug fixes

[SEQ-8851] Crash with JAWS screenreader in quantize settings
[SEQ-8834] ARA: movement of multiple objects is now updated in the ARA plug-in
[SEQ-8833] 'Remove ARA' in project status dialog did not remove ARA track plug-ins
[SEQ-8912] VST3 resize issues (e.g. Softube plug-ins)
[SEQ-8886] Issues with volume automation drawing in virtual wave projects
[SEQ-8908] EN version only: wrong formatted tooltip for stop button in transport window
[SEQ-8878] EN minor text adaptions for reset in color setup dialog
[SEQ-8775] Object end changes by moving start before previous object could not be reverted anymore by moving mouse
back
[SEQ-8839] Display issues with last sample of right channel in stereo wave files
[SEQ-9011] Issues with older mixer skins and controls at right border
[SEQ-9063] Crash while moving objects to another track in 'Link curves to objects' object mode
[SEQ-9001] MIDI file import could crash for files with many tracks
[SEQ-8990] Missing object editor update when switching between projects
[SEQ-9071] Global option for switching off tempo changes for MIDI objects was ignored
[SEQ-9114] Plug-ins on mono tracks were loaded with stereo configuration (and set to mono only with first playback start)
[SEQ-9165] Track editor : Wrong display of hover state for scroll up/down buttons
[SEQ-9073] Some GUI fixes (e.g. wrong audio input color in track editor canis skin)
[SEQ-8837] Plug-in name in arranger plug-in slots and automation lanes was truncated too early

09/20/2024 Samplitude Pro X8 Version 19.2.1 Build 24220

[SEQ-8867] Improved disabling of commands given while recording with playback is active
Export via preset is also disabled now.
Paste commands are disabled now (they trigger a status line message "This command is not available if a recording with
simultaneous playback is running.")

[SEQ-8861] New take naming template "(take name)_(tracknumber)"
Track number now uses 3 digits in projects with more than 99 tracks

Use ini setting [Factors] Force3DigitsForRecordTrackNumber=1 to always use 3 digits
(Automatic take naming already can be set to 3 digits in the advanced recording options)

[SEQ-8788] Interleaved file playback and export optimized
Bug fixes

[SEQ-8857] Accessibility: Enter and End key didn't work in mixer anymore (since Build 24218)
[SEQ-8869] Display issues with (missing) track editor in wave projects
[SEQ-8867] New focus handling for docking windows (activate inactive window instead of closing it) was missing for e.g.
screen keyboard, FX browser and info manager

08/21/2024 Samplitude Pro X8 Version 19.2 Build 24218

[SEQ-8340] View options: Scaling the waveform with fades/curves now has an additional scaling option for object fades and volume
curves only (without track volume and curves)

This new option also is the new default setting
Import / Export

Export dialog
[SEQ-8061] New properties in file naming template editor

New "Channel count" property: number of audio channels of exported file
New more "fine-grained" date placeholders

[SEQ-8061] Improved properties in file naming template editor
"Bit depth" placeholder now without "Bit" unit for more flexibility
Two separate "Sample rate" placeholders, in Hz and kHz, both without "Hz"/"kHz" unit for more flexibility
Legacy bit depth and sample rate placeholders will be replaced automatically when loading old export
presets or naming template presets

[SEQ-8060] "Put in Subfolder" has also a template editor like the one for file name now (instead of just an edit field)
[SEQ-4111] New audio files are now automatically placed into an "Audio" sub folder of the project folder
Bugfixes

[SEQ-8228] Export into Surround+Stereo file failed when Stereo Master and Surround Master are routed to the
same device number
[SEQ-8586] Track freeze / unfreeze commands didn't work for multiple tracks
[SEQ-8586] Wrong track name after unfreeze
[SEQ-8558] Export dialog: Wave with codec didn't work correctly
[SEQ-8650] Issues with BWF MP2 export



[SEQ-8731] Issues with file names for multi format export with choose filename later
[SEQ-8734] Mono export issues
[SEQ-8765] Latency compensation issues with realtime export
[SEQ-8708] Export dialog - realtime export

Possible endless requester "project is already open"
Option "from project start to last object" didn't work correctly

Automation 
[SEQ-7280] Move automation points via object move shortcuts (Ctrl+Alt+1/2) now also works with step width 2 and allows
value change with volume change shortcut (Ctrl+Alt+7/8)
[SEQ-8075] [SEQ-6985] New commands in automation menu to show only Vol/Pan/AUX/EQ/Plug-in automation lanes
[SEQ-8578] Don't show automation in crossfade editor
Bugfixes

Link curves to objects
[SEQ-8077] Creation of several automation points with wrong values when using timestretch in object
editor
[SEQ-8050] Avoid creating automation points in empty curves
[SEQ-8029] Moving objects with menu commands or keyboard shortcuts could delete Latch automation
[SEQ-7712] Objects moved to another track could loose object automation
[SEQ-7712] Wrong automation lane display after moving objects with automation behind project end
[SEQ-8649] Issues with latch automation and "Link curves to objects" after playback stop

[SEQ-8587] Show automation lanes command didn't work for multiple tracks
[SEQ-8152] Automation preview didn't work correctly for AUX sends
[SEQ-8694] After switching between object and track automation the deactivated automation could still have
selected points that responded to commands
[SEQ-8773] Missing updates for automation button of internal FX

Arranger / Track editor 
[SEQ-7886] Submix folder handling via menu and shortcuts
[SEQ-8354] New menu command to select only the active track only (default shortcut Shift+Alt+Enter, only available after
resetting shortcuts or ini)
[SEQ-8524] With "Continuous playback while editing" the cut mouse mode shows the scissor cursor also while playback is
running
[SEQ-8424] Reverted to old style range cursor
Bugfixes

[SEQ-8300] Timestretch / pitch-shift mouse mode: The object end handle at right object border is shown even if the
end is covered by the next object

This enables the user to edit the time-stretch factor in this situation
Link markers to objects

[SEQ-8522] Issues with some object modes when arranging objects via menu Object > Move
objects/crossfade
[SEQ-8535] Ignores markers following the moved objects when "Link until silence" is active

Folder tracks
[SEQ-8556] Recording track color highlight was not displayed in closed folder tracks
[SEQ-8570] Wrong object border display in folder tracks with reference track
[SEQ-8317] Waveform did not zoom in closed folders
[SEQ-8316] Resizing of multiple tracks could open folders and showed hidden tracks
[SEQ-8401] Very small objects were not displayed in folder view
[SEQ-8623] Menu for folder refrence track only supported up to 126 contained tracks and didn't use menu
columns
[SEQ-8601] Routing issues when adding new tracks inside or after submix folder

[SEQ-8456] Optimized object group number display for small objects
[SEQ-8517] Optimized object handle positions
[SEQ-8590] Issues with object/start end handling in footer for small objects
[SEQ-8604] Context menu for peakmeter was missing in arranger and track editor
[SEQ-8065] Track editor updates

Dual pan was missing in vertical skin
Phase button didn't work in horizontal skin with active dual pan
Blue fader handles for busses similar to mixer

[SEQ-8646] Mouse wheel lock for faders and knobs after scrolling in track head didn't work anymore
[SEQ-8643] Graphic issues in track head with dual pan
[SEQ-8378] Track number in submix folders was hard to read in Carbon skin
[SEQ-8737] Wrong object start when dropping multiple audio files from explorer
[SEQ-8684] Casual wrong hiding of newly created tracks
[SEQ-8763] Re-ordering tracks in CD arrangement mode didn't work anymore

Surround handling
[SEQ-8494] [SEQ-8550] Better access to the Surround downmix matrix from mixer AUX/Output area

Tooltip for Shift+Right click on AUX send
Menu command in the AUX send menu renamed to "Surround downmix matrix"
Menu commands to access downmix matrix in track output menu added

[SEQ-8510] Phase invert option for surround sources
Available in left click menu in mixer panning section
Display in surround pan dialog via tab menu

[SEQ-8514] New menu entry "Remove output routing" in tabs of track pan dialog (for non-primary outputs only)
[SEQ-8615] Initial surround panner setup for tracks can now be controlled via presets containing the text "Default", search
order is

default_mono_/default_stereo_ + Surround-Presetname (gss), e.g. "default_mono_5_1 ITU"
 Use the "Save as default" entry in the preset menu

Previous template.vip mechanism is removed



Bugfixes
[SEQ-8318] Interleaved / surround objects drawing issues
[SEQ-8360] Object handling improvements for surround folders and folders with reference track

Select next / previous object shortcuts
Zoom to selected objects
Preview mouse mode
Fade handles menu
Audio marker display

[SEQ-8319] Importing interleaved wave files as (surround) folders sometimes broke already existing folders
[SEQ-5218] Importing an interleaved wave file on a surround folder with different channel count now show a
warning message about creation of a new surround folder
[SEQ-8513] Some routing issues in surround panner (doubled primary out display, bypass inconsistencies)
[SEQ-8287] Surround folder missing display for incomplete mute/solo/monitoring states
[SEQ-8287] Surround folder monitoring switch didn't work
[SEQ-8534] Selecting a plug-in as surround panner closed the panning dialog
[SEQ-8555] Opening online help with F1 in pan dialogs was broken
[SEQ-8478] Some issues with LFE loading from surround setups fixed
[SEQ-8514] Missing updates of tabs in pan dialog after using output/AUX bypass or reset in mixer
[SEQ-8603] Space didn't trigger playback in pan dialogs
[SEQ-8527] Surround and pan dialogs flickered while moving
[SEQ-6241] No routing matrix when routing from surround bus / folder to stereo (did only work for surround
masters)

When inserting the first surround bus the dialog shows "Surround master" according to existing[SEQ-6241] 
functionality
[SEQ-8554] Copy-Paste surround folder: Faders were not linked in pasted folder
[SEQ-8755] Wrong mixer surround peakmeter display for more than 12 channels
[SEQ-8728] Monitoring section: upmix matrix dialog from stereo master to surround was not available anymore
[SEQ-8747] Disable primary output editing for surround busses (could result in crashes)
[SEQ-8684] Adding surround folders created several undo steps

[SEQ-8615] Mixer setup changes
New option "Force mono tracks"
This way you can benefit of the above surround preset handling for mono tracks
New preset "Surround (Mono Tracks)"
Left click in mixer now opens drop down, right click opens dialog

Take handling / Take lanes
[SEQ-8630] Allow to delete obsolete or all take entries in project status dialog - added progress bar
[SEQ-8080] Audio and MIDI takes can be switched together in take lanes
[SEQ-8617] Snap didn't work in take lanes
[SEQ-8613] Take number did grow when just moving objects, possibly leading to delayed playback start

Window handling / Docking
[SEQ-8405] Use Ctrl key while dragging a window to avoid docking
[SEQ-8395] Mixer size is stored globally now

 Disabled horizontal adaption of mixer window when changing projects or adding tracks
Plug-ins / ARA

[SEQ-8540] ARA support for Syncro Arts Revoice Pro Link 5
[SEQ-8541] ARA support for RipX DAW (under construction)
[SEQ-8700] ARA support for VocALign 6 Pro (under construction)
Bugfixes

[SEQ-8436] Audio to MIDI: Creating a new track if needed didn't work anymore
[SEQ-8472] Invalid ARA object state after unfreeze
[SEQ-8386] Melodyne: In some projects with tempo markers, Melodyne no longer showed blobs
[SEQ-8612] Problems with Vocalign Ultra if inserting into a project after removing it before
[SEQ-8707] Wrong plugin editor size after switching from parameter dialog
[SEQ-8697] Cursor drawing glitches in marker lane after bypassing plugins
[SEQ-8729] Crash in AutoAlignPost(ARA) while using object time stretching

[SEQ-6021] Strip Silence: silence detection reworked
[SEQ-8714] Improved performance after closing system dialogs or inside of menu / keyboard setup
[SEQ-8445] "log" and "exp" naming for fade curves swapped to be consistent with common naming
Improvements of display on HDPI/4k monitors when using application scaling (still under construction)
Bugfixes

Crossfade Editor
[SEQ-8682]  F10 could not be used as shortcut
[SEQ-8417] Cursor key handling disabled, e.g. to avoid conflicts with arranger zoom commands
[SEQ-8580] Folders were displayed with black background in crossfade editor
[SEQ-8019] Take Lanes: Take lane state wasn't restored when closing the crossfade editor
[SEQ-8609] Possible focus issues after closing crossfade editor
[SEQ-8657] Footer volume display was still visible and active

[SEQ-8336] Crash when playing objects with the same compressed file on different tracks and multiple CPU cores used
[SEQ-8400] Possible wrong grid bar text color after skin change and restart of program
Recording

[SEQ-8727] Crash while record start after exchange USB hard disc
[SEQ-8712] GUI Performance issue with interleaved recording
[SEQ-8473] After deleting a recording, 'Stereo Pan' could be displayed in the object

Mixer
[SEQ-8355] Sends On Fader didn't show the fader handle in the target AUX track
[SEQ-8374] Only first surround bus fader handle was colored blue
[SEQ-8374] Improved fader handle reset after deactivating Sends-on-fader



[SEQ-8355] AUX send to same track can't be activated anymore
[SEQ-8303] Shift-click for finetune tooltip description was missing for some mixer, track editor and object editor
controls
[SEQ-8385] Shortcut Ctrl+A for selecting all tracks now considers tracks that are only visible in the mixer if the
mixer has focus

Time display
[SEQ-8549] Lyrics marker display flickered while recording
[SEQ-8568] Graphic glitches with time unit milliseconds
[SEQ-8367] Time display: text was not centered

[SEQ-6784] Missing file menu entry for range list export added
[SEQ-8552] Prevent freeze command for master and folder tracks
[SEQ-8258] After closing Spectral Cleaning without any edits, no FX file will be created

Confusing SC marker in objects is not used anymore
Applied SC can be seen by audio markers

[SEQ-8591] Several scaling and drawing issues with nudge edit in toolbar
[SEQ-8648] Some language adaptions (DE/EN/FR)
[SEQ-8569] Prevent sorting by columns in routing manager
[SEQ-8158] HWC focus was changed for audio preview in file or soundpool manager
[SEQ-8531] Possibly corrupted mixer layout after maximizing
[SEQ-8633] Fixes some inconsistencies betweeen main menu, offline FX, automation and help menu
[SEQ-8554] Several fixes for copy&paste of tracks (e.g. copy of missing VSTi or AUX busses)
[SEQ-6842] VSTi playback could be silent after switching engines

05/13/2024 Samplitude Pro X8 Version 19.1.4 Build 23433

[SEQ-8274] Improved "Project status" dialog  
Shows number of stored takes in project
ARA Info now also works for other plug-ins than Melodyne
[SEQ-8630] Allow to delete ARA, obsolete or all take entries with "Clean up" button

Bugfixes
[SEQ-8334] Carbon: wave editor grid was hardly visible
[SEQ-8610] [SEQ-8607] FR language text fixes and improvements
[SEQ-8620] Crash after inserting external FX from FX browser
[SEQ-8602] Possible audio distortion when playing objects with AUX send
[SEQ-8595] Export dialog: 'Split at marker' could overwrite previously created files
[SEQ-8538] Grid and marker track didn't scroll if the first visible track was hidden
[SEQ-8528] Crash after changing speaker configuration from surround pan dialog
[SEQ-8525] Automatic plug-in scan in system and user directories could not be switched off anymore
[SEQ-8532] Crash when adding VST instrument by drag and drop
[SEQ-8488] Phase invert button in mixer could not be operated with Enter key
[SEQ-8505] Crash with marker list export fixed
Multi-Format-Export (exporting more than one format at once)

[SEQ-8519] Split at marker option didn't work correctly
[SEQ-8475] Exporting of selected objects didn't work correctly
[SEQ-8504] Writing ID3 and other meta data didn't work

03/12/2024 Samplitude Pro X8 19.1.3 Build 23431

[SEQ-8411] New command "Reset program settings to default" in help menu, does the same as loading the default INZ container in
start selection dialog or program settings
[SEQ-8333] Export naming templates: marker number placeholder now defaults to 2 digits again (using more digits only if total
number of markers exceeds 99)
[SEQ-8339] MIDI SysEx is now activated automatically without message box when using HWC or MMC
Bugfixes

[SEQ-8349] M4A/AAC Import: 'sample count zero' error after importing more than one file
[SEQ-8449] Range based copy including automation data created ramps
[SEQ-8452] Object plug-in browser always inserted in first slot, not after existing plug-ins
[SEQ-8440] Crash after editing automation curves 
[SEQ-8246] Track head mute/solo/record/lock states were not correctly displayed immediately after skin change 
[SEQ-8397] Problems with drag'n'drop on the last track when it was an empty folder
[SEQ-8341] Internal FX dialogs could not be brought in front when re-opening 
[SEQ-8363] VSTi: No 'project changed' state was set after inserting a VST instrument
[SEQ-8394] Possible crashes in AAF Export with option "Copy only the used audio material"
[SEQ-8466] MIDI Editor: Possible Crash when notes were selected and the controller editor window was too small
[SEQ-8381] Export dialog: Naming templates didn't work correctly with realtime export
[SEQ-6108] Problems after deleting and rewriting of an automation from internal plugin GUI
[SEQ-8332] Creating a new project with a new name from a template triggered the compatibility warning about saving older
versions projects
[SEQ-6128] No update of selection marks in mixer after drag'n'drop of plug-ins
[SEQ-8472] SpectraLayers: crash during unfreeze fixed
[SEQ-8328] Export in multiple formats didn't work for multi-track export
[SEQ-8296] Some filename templates didn't work correctly for multi-track export



[SEQ-8320] Duplicate and copy of folder tracks didn't work correctly
[SEQ-8415] Possible wrong export file names if they contained '.' in object or project names
[SEQ-7911] Volume automation was modified when drawing in an empty lane
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[SEQ-8393] VST MIDI Send to another track didn't work anymore
[SEQ-8365] Some VST3-Plugins didn't work as MIDI-Plugins (e.g. BlueArp)
[SEQ-8371] Crashes when changing DeNoiser sample while playback
[SEQ-8412] Play cursor flickered when changing the start position during playback
[SEQ-8384] Line breaks entered in the info manager for object comments were not displayed correctly in the object editor
[SEQ-8366] ARA: Program freeze with VocAlign plugins after inserting as track effect in empty track
[SEQ-8416] ARA: Crash after editing in the info manager
[SEQ-8357] Export dialog: Export to 32bit float with glue selected objects option active was exported as 24 Bit instead.
[SEQ-8406] Wrong object footer text color for folders in Carbon skin
[SEQ-8400] Wrong arrangement text color after skin change and restart of program
[SEQ-8398] Some corrected translations (EN)
[SEQ-8380] Muted objects drawn with half wave forms created graphical glitch
[SEQ-8369] Wrong AUX send coloring in mixer with -inf send level
[SEQ-8346] Marker line was drawn while moving CD and punch markers
[SEQ-8408] Duplicated drop-down display in object editor
[SEQ-8274] Possible issue with creating too many take entries after moving recorded objects
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[SEQ-7282] Multiple track selection with shortcuts in arranger and mixer
New commands (under Tracks > More > Select tracks)

"Select all tracks"
"Add previous track to selection" (shortcut Shift + Alt + Up)
"Add next track to selection" (shortcut Shift + Alt + Down)

Use Ctrl + A can to select all tracks
in the mixer
in project window, if track name has focus

[SEQ-7944] New main menu commands added that were only present in context menus before
Menu Edit > Tempo >Tap tempo... for the Tap Tempo Dialog from the tempo menu of the transport console
Menu Edit > Crossfade > Crossfade editing >Log./exp. from the object fade handle context menu
Menu Track > More > Track color… for the color menu from the track head color area

[SEQ-8255] Skin change now also resets default track / object colors
[SEQ-7423] A vertical line is drawn while moving a tempo marker 
[SEQ-7791] Separator between tracks optimized - further fine-tuning
Bugfixes

[SEQ-8311] Add some missing localisations (ES/FR)
[SEQ-8302] Column widths in Marker manager were not restored
[SEQ-8289] Group numbers in objects were hidden even when enough space was available
[SEQ-8256] Zoom to selected objects didn't zoom completely if the selection included all tracks
Plug-ins / FX 

[SEQ-8315] Crash when opening EQ in surround tracks
[SEQ-8293] Playback dropouts with FabFilter plug-ins used on objects
[SEQ-8307] Problems to stop playback with the space key in Soundtoys plug-ins
[SEQ-8288] Pasting a copied object plug-in chain to multiple selected objects inserted the plug-in (chain) on the
active object only
[SEQ-8337| Mixing on neighbouring mono channels of an output device caused crackling for external FX
[SEQ-8257] Track FX chain reset and preset loading via Track FX button menu didn't work for multiple selected
tracks
[SEQ-8356] Problems with VST3 Plug-ins without parameter name handling
[SEQ-8348] UADx-Plugins didn't recall their settings from project when using latest UADx update
[SEQ-7804] ARA VocAlignUltra state was not completely restored after project loading (fix also requires latest
VocAlign update v 1.3.67.1)

Mixer
[SEQ-8306] Removed tooltip for scrollbar in mixer
[SEQ-8322] Some fixes for restoring mixer window size after loading a project
Sends on Fader

[SEQ-8248] Sends on Fader could cause overwriting of AUX send after using the "visible" checkbox in
AUX send dialog
[SEQ-8313] Surround master AUX sends were activated with Sends on Fader
[SEQ-8314] Issues with AUX automation (e.g. writing automation in surround busses)

Recording
[SEQ-8284] Recording settings: "Format" label would be visually covered by group box frame (EN localisation only)
[SEQ-8232] Warning added for attempts to use track output recording and the performance option "Deactivate FX
on empty or silent tracks for ASIO" on

Import / Export
[SEQ-8239] Screen flickering when exporting multiple wave files without opening them
[SEQ-8254] Improved overwrite warning if files are already opened
[SEQ-8294] Glue Objects until silence: Selected objects without cuts were not processed
[SEQ-8338] AAF/MXF Import: Embedded audio was always silent

MIDI / VSTi
[SEQ-8356] MIDI Plug-ins didn't work anymore from build 23418
[SEQ-8347] VSTi: Hanging notes with Yamaha NoteOff conversion if track MIDI output channel was set

Crossfade Editor
[SEQ-8295] Vertical scrolling with mouse wheel didn't work after hidden tracks
[SEQ-8298] Track editor command / button is now disabled
[SEQ-8298] Mixer keys (Cursor keys, Pos1,...) were not handled
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General 
[SEQ-8249] Changed several default program settings )(only for new installations or after reset of program settings

Following settings are default active now
Scan user and system VST folders automatically
Recording: Save each take in a new file 
Destructive Effects: Generate a new file for each FX calculation

Crossfade editor: Default relative zoom width for crossfades 10%
Metronome: Default volume -10 dB
TrackSpeed: Default buffering time 2 s

[SEQ-5653] .ini files for program settings and plugin favorites are saved instantly, not just at end of a program session. So
changes in the settings are maintained even after a crash.

Previous .ini files are kept as *_backup.ini and may be restored manually by renaming the files
[SEQ-8277] Reset stored window positons of several windows (Export, Crossfade editor) when using "All windows to
mainscreen" command with pressed Shift key
[SEQ-7936] The path of the active project file is logged in the crash.log in case of a crash event
[SEQ-8122] Updated to Qt 6 framework
[SEQ-7980]  forPerformance improvements

Use of many files (e.g. with every take in a new file) or many objects
Recording / playback with many tracks / devices
Undo with object EQ on many objects

Recording / Playback
[SEQ-7980] More than 64 Mono In or Out Devices are grouped into several submenus
[SEQ-8010] Support for  (depending on audio device) - level still can be adjustedASIO float recording of clipped audio
after recording
[SEQ-7991] Support for IK AXE ASIO device with only one input and three output channels, 

Last channel of devices with odd channel count can be accessed in general
[SEQ-7798] New playback option added to pause autoscroll until play stop when clicking in the arranger
[SEQ-7702] Pause Autoscroll when 'Continuous playback while editing' is active

Take Lanes
[SEQ-7974] Take Lanes for MIDI objects

 [SEQ-7765] Cutting takes with grouped recordings doesn't break the grouping anymore if a take is missing for some tracks
[SEQ-7670] Lanes are now restored after loading a project

Arranger 
[SEQ-8023] Changed default object background color (Carbon only)
[SEQ-7791] Optimized separator between tracks
[SEQ-7998] Hovering mouse over grid bar shows range cursor
[SEQ-8031] Restructured object menu

Access to recently used object menu commands
[SEQ-7818] In object footer, a text "Warp" is displayed if at least one AudioWarp marker is present in object

Crossfade Editor
[SEQ-8023] Skin is switched with arranger skin + optimized colors

Mixer / Track Editor / Object Editor
[SEQ-7073] , when increasing sizeMixer can have longer faders
[SEQ-8049] Smaller edit steps with mousewheel and arrow keys when using Ctrl+Shift keys together (especially using 0.01
dB  for volume / gain)
[SEQ-8252] Apply track timeshift to multiple selected tracks
[SEQ-7877] Mixer reset EQ command now fully removes the EQ116 instances
[SEQ-6957] AUX Sends are now created without initialization to -89 dB

Active sends with level -inf / off are still marked active now
Send level for new AUX buses can now be adjusted directly after first mouse click, no need to set the level with a
2nd click any more

[SEQ-5663] Object editor AUX bus creation is now also possible with bypass switch (+ some fixes)
[SEQ-7927] Unified default stereo enhancer algorithm for objects and new AUX sends with new tracks
Bugfixes

[SEQ-8109] Change from 'VCA' to 'AUX' button labeling wasn't reverted after switching off sends on fader
[SEQ-8253] Track output field in mixer were shown partly black when the track had no color and were routed to
more than one buses

ARA / Plug-ins
[SEQ-6904] ARA plug-ins can now be inserted as track effects

Plug-in instances are automatically inserted into all track objects, also when new objects are added (e.g. after
drag'n'drop or loading of audio to this track)

[SEQ-7971] ARA support for ASAP Spectral Surface and ASAP Pitches Brew Plug-in
[SEQ-8208] SpectraLayers has a docking window like Melodyne
[SEQ-8203] Support for drag&drop files from VST plug-ins to the host project

e.g. for SpectraLayers
Automation

[SEQ-6712] Deletion of ranges of track automation optimized: No automation points are created at selection borders if a
curve is flat in that range
[SEQ-7299] Prevent automation ramp from project start when creating an automation point via double click and then
dragging it



[SEQ-8039] Drawing on objects with volume automation mouse mode automatically activates volume curve for objects
(similar to track automation behavior)
[SEQ-7958] "Delete all curves" now works for multiple selected tracks

Export dialog
[SEQ-7890] Check sample rate compatibility for each selected codec before starting
[SEQ-7751] ISRC and [SEQ-8059] CD / MP3 properties in export dialog naming template editor added
[SEQ-7891] Change the unit of the export length directly in the export dialog
[SEQ-8112] New option 'Move to recycle bin when overwriting' - When a new export overwrites existing files, these are
deleted to the recycle bin for a possible restore.
[SEQ-8085] Button text "Browse..." replaced with folder icon
[SEQ-7498] Select ten most recent custom folders from list
[SEQ-8187] Resampling quality button is deactivated if no sample rate change is active
[SEQ-8196] When activating an file format, the corresponding format settings are now shown automatically
[SEQ-8097] New option to consolidate bordering objects: Glue selected objects until silence 
[SEQ-8188] Renamed default export file naming template to "Project Name"

only for new installations or if a user deletes all naming templates
Bugfixes

[SEQ-8220] Pressing the 'x' button in the 'Overwrite existing files?' query dialog didn't cancel exports 
[SEQ-8219] Multitrack Export: Wrong file naming with option 'Choose Name later'

[SEQ-7929] Project Files Dialog includes files referenced in revolver tracks
Project files dialog will open automatically if referenced files are not found

Docking
[SEQ-6101] Change wording from "Monitoring" to "Monitoring section" in the + menu of the docker

MIDI
[SEQ-7609] Extendeded soft split for MIDI (  activated by ini entry [Factors]experimental,
SplitNotesWhenSplittingMidiObject=1)

If soft split is enabled, MIDI notes on object edges are splitted when MIDI objects are splitted
[SEQ-8122] Screen keyboard: added scrolling with mouse wheel and zooming with ctrl + mouse wheel

Bugfixes
Hardware controller

[SEQ-8226] Opening mixer did reset controllers assigned by MIDI learn function 
[SEQ-8141] Help button or F1 opened wrong or no help window

[SEQ-8236] Take lane editing problems after inserting or re-ordering tracks while take lanes were open
[SEQ-8216] Multichannel files could not be loaded multiple times
[SEQ-8244] Distorted audio when using surround AUXes without own pan setting
[SEQ-8181] Wrong display of object handles with active object footer and disabled 'Volume handles on top' option
[SEQ-8189] Export to 24Bit Wave - CD markers could disappear in wave project
[SEQ-8249] Crossfade settings: Default absolute zoom width could not be set below 500 ms
[SEQ-8235] Object resampling could still be marked as active after reverting project sample rate change
[SEQ-8028] Link curves to objects didn't work for submix folders
Plug-ins / FX

[SEQ-8169] ARA crash fix: Some plug-Ins do not support multiple projects at the same time
[SEQ-8234] When copying multiple tracks with VSTi to another project, only the first VSTi was transferred
External FX

[SEQ-8269] Warning when inserted / opened without hybrid engine
[SEQ-8259] Crash when closing project or program with open external FX dialog
[SEQ-7854] External FX dialog window caption now correctly displays 'External effect' instead of 'External FX'
[SEQ-7854] 'External effect' dialog caption didn't show track and slot number like in other plugin dialogs
[SEQ-8043] The 'External effect' dialog was not hidden on project change although the option to keep it open was
disabled.

[SEQ-8135] Audio gaps when importing CDs with resampling
[SEQ-8145] AIFF Reader updated, some 24Bit AIFF files were not imported correctly
[SEQ-7336] Improved MIDI editor drawing performance
[SEQ-8123] AAF Export: possible crashes with option 'Convert stereo objects' fixed
[SEQ-8079] Stereo objects from mono objects: Wrong channel assignment with interleaved wave files fixed
[SEQ-8079] Stereo objects from mono objects: Stereo objects get time stamps from mono files
[SEQ-8165] *Loudness Adjustment* dialog: Small error in DE localization fixed
[SEQ-7631] File names for recording taken from track names were wrong on first project save
[SEQ-7472] Export dialog is shown on main screen when last position is unavailable (2nd monitor).
Mixer

[SEQ-8126] Wrong surround peakmeter display after mixer resize
[SEQ-8204] Missing mouse-over reset after right click on automation button in mixer
[SEQ-8176] Wrong mixer fader scaling when mixer size was reduced
[SEQ-7939] Keep mixer height when changing projects

[SEQ-8180] The track color setting for tracks with recording in progress was not used
[SEQ-8144] Unintentional multi-selection of markers after using CD index manager
[SEQ-8144] Issues while moving markers beyond other markers
[SEQ-8042] Save complete VIP: Correct handling of files with equal file names in different sub folders of the project folder when
"Keep project sub folders" was disabled.
[SEQ-5124] Issues with project names starting or ending with spaces - these are stripped now
[SEQ-8231] Multiselection for controls in arranger (e.g. monitoring) didn't work correctly 
Monitoring

[SEQ-8212] Correct handling of a bus named "Master" in addition to the stereo master in monitoring section
[  Some monitoring section texts were wrongly formattedSEQ-8154]

[SEQ-8155] Time display
Performance improvements and bug fixes



Spectral Cleaning  
[SEQ-8119] Restore modal state after opening system settings to prevent crashes
[SEQ-8036] Window position on secondary screen wasn't restored
[SEQ-8118] Cursor jumped to view start after editing

[SEQ-7903] Non-functional "Export to Video Pro X" command removed
[SEQ-7805] Load / initialize warp markers correctly for objects with missing audio files
[SEQ-7667] Maximized state of floating docking windows were not restored after reopening the program
[SEQ-6643] Discarding a recent recording is not possible when the object was edited while recording (in according mode "Playback
& editing independent of recording"), the option to discard the recording is skipped in this case now.
[SEQ-5099] Objects could be pasted into tempo tracks
[SEQ-7948] Recording punch-in after entering a loop created unintended objects
[SEQ-7995] Playback jumped when soloing/muting an object with warp markers and the object editor was visible
[SEQ-7976] Playback with 'Continuous playback while editing' playback mode jumped when loop mode was on and edit cursor was
set before the loop start
[SEQ-8022] Display issues with minimum / maximum automation values
[SEQ-7646] Refresh track output routing in mixer was missing when routing fallback to default device was used after deleting tracks
[SEQ-7896] External tools dialog: missing localizations (ES, FR)
[SEQ-7747] Track AUX send automation could use wrong values after stopping playback
[SEQ-7970] Mixer fader remained blue after changing track type back from submix to normal track
[SEQ-8025] Track naming refresh was missing for External Effects and Plugins after Undo
[SEQ-7538] Waveform graphic glitches when Pre-recording option was active
[SEQ-8001] Double click between 2 markers in the marker track created a range for the first track only
[SEQ-8076] 'Building Graphic' hanged after loading interleaved wave via file manager
[SEQ-6547] Menu command / shortcut for track phase invert didn't work for multiple selected tracks and neither respected the "only
invert left channel" setting
[SEQ-7956] Buttons for volume / pan curve activation didn't work for multiple selected tracks
[SEQ-8078] Using the command "Remove unused curves" on tracks without automation crashed the program
[SEQ-8016] Loop length changes of looped MIDI objects in object editor were not drawn
[SEQ-7925] Wrong menu break in context menus might result in invisible entries
[SEQ-8072] Object editor changes for different objects were collected in one undo step
[SEQ-8090] Object manager search didn't work anymore (since build 23117)
[SEQ-6417] Improved time display performance
[SEQ-7853] Prevent ripple with "Link markers to objects" if markers are locked
[SEQ-7777]  [SEQ-7983] Several fixes and improved performance for cursor drawing
[SEQ-8011] External tools dialog: several fixes
[SEQ-8086] Timestretching / Pitch shifting: several fixes
[SEQ-7892] Help browser was sometimes opened twice when using F1 and some help topics were missing
[SEQ-7892] Removed obsolete "Help Index..." main menu entry
[SEQ-8037] Wrong drawing of MIDI notes after soft split
[SEQ-7937] Track manager: issues with color menu handling
[SEQ-7940] Multi Track Export: ensure each track gets its own filename
[SEQ-7505] Some fixes for writing automation
[SEQ-8073] Missing marker redraw for "Link markers to objects" after using menu commands or shortcuts
[SEQ-3432] Track comments were not copied with tracks
[SEQ-8058] Track latency shift was not copied with tracks
[SEQ-8102] Issues with Zoom to selected tracks when all tracks are visible
[SEQ-8111] Crash when adding multiple hardware controllers
[SEQ-8115] [SEQ-8116] Several issues with mixer, crossfade editor and arranger drawing when forcing application defined DPI
scaling
[SEQ-8124] VST3: no output for some plug-ins (e.g. Acon Digital Remix)
[SEQ-8301] Possible missing break in side chain menu, if folders were present
[SEQ-8264] Incorrect position when loading resampled multi channel file into a new folder
[SEQ-8208] Fixed background color for Melodyne/SpectraLayers docking window
[SEQ-6420] Monitoring section plugin menu didn't work with "FX always on top"
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[SEQ-7937] Track manager: drag'n'drop didn't work correctly anymore (Build 23115 only)
[SEQ-6611] wrong position of edit fields in managers
[SEQ-7295] gnudb cd online search didn't work anymore
[SEQ-7669] gnudb cd info: unicode problems with some special letters
[SEQ-5398] keyboard input was partly absorbed by host in edit controls of vst plug-ins (e.g. Melda plug-ins)
[SEQ-7446] Wrong wording for "Reset Quantization" in some languages
[SEQ-7964] Disable vertical scrolling for wave projects
[SEQ-8035] Track manager list import for didn't work for more than 99 tracks
[SEQ-8013] Shortcut list export would not work if  directory did not exist (e.g. after switching to another language)Project Files
[SEQ-5849] missing drawing of object automation for max values
[SEQ-8026] Export dialog: incorrect format extension for example file name
[SEQ-4349] Fixed graphical issues that occurred after resizing the soundpool manager to minimal height
[SEQ-8045] Marker track: markers outside visible area still could be grabbed after zooming or scrolling operations
[SEQ-8056] Problems with setting project position to project start by click in left timeline border, now the gap between marker/grid
buttons and timeline is increased
[SEQ-5408] Issues with damping fader of Denoiser
[SEQ-7986] MIDI editor: some cursors were incorrect for the scrollers



[SEQ-8004] Unwanted minimizing of other tracks when "Maximize tracks automatically" is on
[SEQ-7845] Optimized text colors in managers
Record dialog: 'Resampling to 44.1 kHz' can't be activated
[SEQ-6965] Redrawing issues for track visualization and monitoring (track fx engine)
[SEQ-7954] ARA support for Auto Align 2 plug-in

 Missing undo step creation for routing tracks to submix bus[SEQ-7973]
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[SEQ-7475] Accelerated mouse handling for link curves to objects
[SEQ-6168] Accelerated switching of revolver tracks
[SEQ-7872] Vertical scrolling by mouse wheel dependent on project zoom
[SEQ-7895] Reduced memory usage of EQ116, especially when used in a lot of object instances
[SEQ-7867] Video, folder, tempo and surround tracks/busses aren't listed in the menu for track output recording any more
[SEQ-7874] WMA export removed
[SEQ-6169] Revolver track revision numbers synced for multiple selection: now all tracks get the same revision, so internal revision
don't has to be displayed anymore
[SEQ-7937] Track manager: change track color with single click instead of double click
[SEQ-7957] GUI_NoFocusHandlingWithMixerShortCut.INZ added for disabling new focus handling (introduced with build )22554
[SEQ-7897] "Client/Label" and "Working order" fields in CD burn-dialog TOC are empty in new projects
[SEQ-7912] Warning when disabling options that are neeeded for warping + tooltips when hovering over a warp marker with
deactivated warping
Bugfixes

[SEQ-7882] Occasionally missing display of play cursor in wave projects
[SEQ-7952] Take markers in projects could overwrite existing punch markers
[SEQ-7900] Takes changed their lanes unexpectedly when changing object borders
[SEQ-5774] Noise garbage with room simulator when resampling impulse responses
[SEQ-7928] Save as... for projects could provoke a crash if multiple revolver tracks were included
[SEQ-7922] Take lane issues with freeze/glue
[SEQ-7946] Old takes were shown with imported files or other new objects
[SEQ-7905] Missing take lane updates (e.g. after take manager operations, duplicate objects,...)
[SEQ-7930] After manually copying a project, sometimes audio files couldn't be found when switching revolver tracks
[SEQ-7771] Changes in monitor section could trigger warning for projects created in old version
[SEQ-7960] Shortcuts didn't work while hovering over buttons in arranger and mixer
[SEQ-7963] Possible crash when creating a new project after drag & drop of tracks
[SEQ-7667] Maximized state of floating docking windows was lost after minimizing and restoring the main window
[SEQ-7993] Drawing of automation data over maximum in the first automation lane could produce jump to minimum value
[SEQ-7877] Missing update of track routing dialog after loading a track FX preset
[SEQ-7932] Optimized contrast for arranger beat and sub-beat grid lines
[SEQ-6890] Missing restart of timestretching / pitch shifting after mute / solo in economy engine and also after moving object
while playback
[SEQ-6421] Avoid matching colors between take lanes and automation lanes
[SEQ-7659] Broken object automation mouse editing inside a range and at the end of an object - some remaining issues for
resampled objects fixed
[SEQ-7934] Issues after undo
[SEQ-7504] Crashes with AutoTune
[SEQ-7918] [SEQ-7919] Wrong text in ES language version
[SEQ-7921] Non-functional controls for Blackmagic video output hidden in Samplitude
[SEQ-7831] Wrong automation panel width after project loading
[SEQ-7902] After performing Audio to MIDI Melodyne plug-in was still referenced in audio object
[SEQ-7887] Wrong track name when using more than 99 revolver tracks

[SEQ-7968] fix this for loading old projects, too
[SEQ-7923] Deactivated object automations were still active
[SEQ-7870] Icons in dockable plug-in browser were mixed up
[SEQ-7913] Output were muted when the skin in a wave project was changed
[SEQ-7805] Load warp markers correctly when loading projects that contain objects with missing audio content
[SEQ-7953] Crash in accessibility mode when showing the generic VST GUI for a plugin that has less than 8 parameters
[SEQ-7950] Problems with tempo adaption of objects when changing the project tempo
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What's new in Samplitude ProX 8 ?

The most important innovations in   at a glance:Samplitude ProX 8

Take Lanes: Comping, i.e. combining sections from different recording takes, no longer takes place in a separate Take Composer
window, but directly in the project below the track in the new Take Lanes
Marker track: Markers are displayed in their own track. The height of the track can be freely adjusted so that long marker names are
no longer cut off by following markers. The markers can now also be colored, the Marker track head contains buttons for creating,
coloring and locking markers.
Simultaneous export to multiple formats: In the , at , you can now select multiple formats for simultaneousexport dialog Generate
export.
AudioWarp: Warp markers can now be set in audio objects to touch and move the audio, to correct irregularities in a recording, or to
change the audio rhythmically.
Many :improvements for working in the project window

New, meaningful mouse pointers for the editing areas in the track
Numerically adjustable volume directly at the object
optimized display of notes in a MIDI object
improved default settings for many display options
Color button in the object editor sets the object background color.

Help and manual have been completely revised and updated
VST3 plug-in compatibility improvements.

New features and changes in detail

[SEQ-6605]  for comping audio recordingsTake Lanes
Open via button on the left or command Track "Show take lanes" (default shortcut Ctrl+Shift+Enter)

Replaces old Take Composer function
Take lanes can be shown for just one track

Shows all available takes for all objects in a track
In Universal mouse mode takes can be copied/activated by single click, drawing a range or dragging borders of used takes

this is similar to using the scissor tool in the old Take Composer
With grouped objects on several tracks takes are exchanged on all tracks (multi-track comping)

If takes are not available on other tracks, they are marked with red background
There's an error display in the status bar, if you try to use them

Solo button on track head of take lane
In Range mouse mode you can use Ctrl + C for copying ranges, e.g. from other time positions (without multi-track handling
yet!)
[SEQ-7809] Unused take entries are removed now after deleting objects or loading projects from older versions
[SEQ-7767] Take Composer menu entries and button removed
[SEQ-7736] Tooltips for take lanes added
[SEQ-7735] Constant vertical scroll speed - independent of track height

[SEQ-7040]  markersAudioWarp
Allows stretching of objects audio content (in addition to the project tempo map)
Select the Timestretch mouse mode to edit warp markers

Click into an object for adding a Warp marker at the cursor position
Click and drag an existing Warp marker in the upper half of the object for stretching the object
Click and drag an existing Warp marker in the lower half of the object for moving the anchor position of the warp
marker
Right click on an existing Warp marker to show a context menu

The warp markers are stored in the object, not in the object's audio file. Although they are displayed in the object like audio
markers they could differ for different objects referring to the same audio file.

Copying an object will copy the warp markers, too
Warp markers currently require the Musical tempo adjustment option set to active which is done automatically when adding
a warp marker
Timestretching an object with activated musical adjustment is now possible thanks to the Warp markers
Load/save and undo/redo is supported

[SEQ-7419] Marker Track
Project markers are now displayed in dedicated track

Other markers like CD track indices or Tempo markers still are displayed in the marker bar on top
Track is resizable, displaying all markers according to available vertical space for improved overview e.g. with many markers
Multi-selection of markers is possible for moving, deleting or color assignment
Individual marker colors can be changed via context menu on markers, in marker track head or in marker manager
In the track head there are some useful commands e.g. for creating new markers



[SEQ-7690] Marker lines drawn on top of all tracks when moving markers
Export

Export Dialog
[SEQ-7479] + [SEQ-7480] Multi-format export

 Multiple audio formats can now be exported simultaneously
 In the  dialog, there is now a list of available export formatsExport

It is possible to select multiple formats via the corresponding checkboxes
[SEQ-7879] For quickly selecting a single export format, double-click the corresponding checkbox
Format-specific settings are located next to the format list

To select which format setting is currently edited, click the corresponding format name
[SEQ-7482] New  optionUse current project sample rate

If checked, this will always prevent resampling
Useful when working with export presets and the  commandExport with previous settings

Batch processing
[SEQ-658] Editing of mixer snapshots to add plug-ins and change routing didn't work
[SEQ-7374] New resampling quality options for Sox algorithm

General
64 Bit only, no 32 bit version anymore
[SEQ-7841] New HTML help system, which opens in standard system browser
[SEQ-7154] separate *Support* tab in the *About Samplitude...* dialog

new main menu entry *Help > Support...* which directly leads to the new *Support* tab
Project compatiblity warnings

[SEQ-7819] when loading current projects in older program versions
[SEQ-7771] when opening/saving projects created in older versions

[SEQ-6793] Window order in Docker and menu now synchronized with main View menu
[SEQ-7599] Several wording changes in English options dialog
[SEQ-7616] Adapted default program settings

No automatic volume fader mode change for MIDI tracks
Soft split for MIDI objects
No default assignment of NumLock key for scrubbing
Reduced default number of cores for multi CPU handling
Knob characteristics same as faders
Vertically optimize MIDI-note display
Universal mouse mode
Spectrogram: Logarithmical scaling

[SEQ-7541] Rename "Zoom to selected track(s)" command in some languages (DE)
[SEQ-7536] Adjust some wording and positions in view options
[SEQ-7603] Toggle Loop mode now has the default short cut [Shift] + [L]
[SEQ-7830] Color button in object editor now changes the object background color
[SEQ-7828] Use color / palette menu in track manager and object editor
[SEQ-7163] Folder picker uses new Windows UI
[SEQ-7355] Improved performance for projects containing a lot of automation data

Faster saving and loading of projects
Faster drawing automation data e.g. at wide zoom levels
[SEQ-7526] Faster undo creation by copying only changed track automation curves

[SEQ-7677] Some localization changes for creating stereo objects from mono objects
Arranger

[SEQ-7835] Heights of lanes are also reset when resetting track heights
[SEQ-7811] TS/PS mouse mode always allows range editing similar to universal mode now, independent from previous
mouse mode
[SEQ-7727] Scrolling with mouse wheel is now pixel proportional
[SEQ-6421] Alternating track colors now includes selected tracks as well
Folder Tracks

[SEQ-6567] Track context menu: new Move to folder track functions
New in Track and Folder track menu: Duplicate Tracks
[SEQ-6846] Control monitoring status of contained tracks

If not all contained tracks are monitored, only the border of a folder's monitoring button is shown activated
[SEQ-7736] Tooltips for universal mouse mode added

only visible in extended tool tips mode
[SEQ-7641] Old visual feedback for locked objects via [Factors]OldStyleLockMark=1
[SEQ-5651] Updated mouse cursors in arranger, docker, and MIDI editor to better show what mouse dragging will do
depending on the area you mouse over

Drawing a selection frame
Selecting a range
Drawing a curve
Moving an item

Mixer / Object Editor / Plug-ins 
[SEQ-7863] Allow processing for shortcuts in VST plug-in windows, if shortcut is marked as "global"
[SEQ-7741] Object Editor: The "Reset" command for the EQ section now fully removes the EQ116 instance
[SEQ-7353] + [SEQ-7657] Mixer: With Sends on fader, the color of a faders shows, whether the send is pre-fader,
post-fader, or direct-out

This can now be set on the fader via context menu as well (including multiple selection)
MIDI

[SEQ-3435] Tempo maps are now considered by looped MIDI objects
[SEQ-7382] Copying/pasting MIDI with active tempo map works now correctly
[SEQ-5429] MIDI arranger notes coloring improved for better contrast with different background colors.
[SEQ-6615] The pitch range of a MIDI object displayed in the project window is now only the range actually used by the



contained notes.
This behavior can be turned off under View options > Vertical MIDI auto zoom

[SEQ-7452] Quantize settings dialog (Toolbar and MIDI editor): Enable "End Q" to quantize note ends
[SEQ-7484] MIDI objects in project window: Notes of muted objects are colored grey like with single muted notes
[SEQ-7501] Support for Harmonica and 7 more Music Maker shop instruments
[SEQ-4500] Performance Issues with Vita Organ - fixed (download new version 2.6)

EuCon Hardware Controller
[SEQ-7420] Suppress error message during startup if EuCon is not installed and EuCon option was set

Bugfixes
[SEQ-7744] The small red focus triangle was not displayed in the track info (track header) if the track was dragged very
small. It wasn't always visible on folder tracks either
[SEQ-7825] Dialog 'Marker with Name and Number' showed checkbox for audio markers when not recording
[SEQ-7800] System option "Create fades for new objects..." had started the VocAlign PlugIn - fixed
[SEQ-7245] If ranges were selected, new tracks were inserted in unexpected places
[SEQ-7785] There are plugins that produce stuck notes when the noteoff comes in the form of a noteon with velocity 0. This
is now converted to NoteOff.
[SEQ-7778] MUS file decoding might produce some artifact samples initially
[SEQ-7849] Borders for lanes were missing
[SEQ-7621] When generating file names from track names not all invalid characters are filtered out
[SEQ-7850] Pasting copied tracks overwrites track color and resets aux sends / plug-ins even when the respective options
were not selected
[SEQ-7822] Missing or wrong shortcuts in object context menu
[SEQ-7566] Missing refresh of track record buttons after loading or inserting tracks
[SEQ-6862] Avoid crashes with track FX monitoring by restricting economy engine to 16 threads by restricting maximum
thread number
[SEQ-7700] Export Dialog - Preset Handling: AAC and WMA codec settings were not restored
[SEQ-7793] Export Dialog - Multi-format export: several fixes
[SEQ-7297] External FX presets did not show their name when loading a VIP using it.
[SEQ-7359] Adding a tempo grid position marker during playback in tempo map grid mode added an inactive marker
[SEQ-7610] Converting Flac to Wave was very slow
[SEQ-7512] After manually copying the project, unfreeze could not find audio files in some cases
[SEQ-7265] Link status was not saved in mixer snap shots
[SEQ-7363] Broken linked channel offset in Sends on fader mode
[SEQ-7823] Crash with trim object
[SEQ-7623] Dialog for setting file name (choose file name later) in export dialog did not allow periods (.)
[SEQ-7694] Show surround master output devices in mixer (again)
[SEQ-7871] Export of tracks with VSTi output, also considering tracks that send MIDI to these VSTis.
[SEQ-7479] Fixed 384 kHz MP3 export when exporting in multiple formats
[SEQ-7914] Fixed several tooltip inconsistencies (VSTi slot in track editor, toolbar , ...)control for nudge object step size
[SEQ-7081] Docker window caption was offset
Automation

[SEQ-7355] Fix undo acceleration for object automation curves
[SEQ-7659] Broken object automation mouse editing inside a range and at the end of an object

Recording
[SEQ-7439] Punch In while playback - recorded object was longer than wave
[SEQ-7342] Record and playback devices had an unexpected reset after using "Record standard output"
[SEQ-7570] Unwanted cuts after recording

VST Plug-ins
[SEQ-4960] [SEQ-6629] Resizing issues with some VST3 plug-ins (iZotope Ozone, HOFA, FabFilter)
[SEQ-7601] VST3: no output for plug-in 'The God Particle'
[SEQ-5998] Checkbox "Scan user and system VST folders automatically for new plug-ins" is not initialized correctly
before the first VST scan of the session
[SEQ-7671] When copying certain VST3 plugins between objects in the object editor, the parameter settings were
not copied

 +  VST3: general compatibility fixes for window resize and side chain handling[SEQ-7696] [SEQ-7772]
[SEQ-7064] VST3: transmitting track color to plug-ins didn't work in some cases (wrong alpha value was used)
[SEQ-7899] Missing update of track name in VST3 plug-ins after moving them via drag'n'drop in mixer

[SEQ-7576] Wave editing with SoundForge could produce a peak at the end
Arranger

[SEQ-7624] Docking: Floating project windows are missing the window title update when changes are made
[SEQ-7433] Missing redraw of grid lines when scrolling vertically
[SEQ-7546] Video flicker in softscroll mode
[SEQ-7691] Objects were displayed shifted while scrolling horizontally
[SEQ-7487] Broken track head after undo called from menu or history

MIDI
[SEQ-7597] Crash in MIDI-Editor when using menu command "Split notes at playback cursor position"
[SEQ-7567] After double-clicking on a MIDI object, it sometimes took a long time for the MIDI editor to display the
content
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